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Requirements 

discQuest requires an Apple IIos computer with: 
2MB RAM 
3.5" floppy disk drive 
SCSI Interface Card 
CD-ROM Drive & proper cables 
System Software 6.0 or higher (only if using a hard disk) 

A color monitor is required to view color pictures, but not required if 
you only use the gray-scale (black and white) imaging features. A 
hard disk drive IS recommended but not required. The System 
Software provided on the Diskette System is System 6.0.1. 

Installation 

Hardware Installation 

If you are installing a complete discQuest bundle, refer to the 
RamFASTTM manual that came with your discQuest bundle for 
information on installing the RamFAST card and attatching the CD­
ROM drive to it. 

IMPORTANT: If you are adding a CD-ROM to an existing SCSI card 
make sure that your boot hard drive's SCSI ID is higher than that 
of the CD-ROM. The discQuest CD-ROM Drive comes factory preset 
with SCSI ID #1 so you should not have to modify it, but other CD­
ROM drives may be set at #4,#6, or others. Refer to your CD-ROM 
Drive manual for information on how to change the SCSI ID. 

For discQuest users without a hard disk drive, you will probably 
want to make sure that your computer always boots from the 3.5" 
disk drive. To do this, enter the IIGS Control Panel (press the Control, 
Apple, and ESC keys simultaneously). Use the arrow keys to highlight 
"Control Panel" and press the Return key. Use the arrows again to 
highlight "Slots" and press Return. The bottom of the Control' Panel 
window should now have an item "StartUp". Use the arrow keys to 
make sure this option is set to "Slot 5" (left and right arrows will 
change the setting). Once StartUp is "Slot 5", press the Return key. 
You can now reboot the computer and it will start up from Slot 5 (the 
IIGS's 3.5 inch floppy disks). This is necessary because the IIGS 
cannot boot from the types of CD's discQuest works with. 
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Software Installation 

disc Quest uses Apple's Installer program for trouble-free installation 
of discQuest on a hard disk drive. If you do not have a hard drive, 
all you have to do is boot the floppy labelled Diskette System. 

To install discQuest on a hard drive, boot 'your hard drive to the 
"Finder" program, then insert the Hard Disk Installer disk into any 
3.5" drive. A window should open with the contents of the Hard Disk 
Installer disk. (If a window does not open automatically, double-click 
on the "discQuest" disk icon to open it). Then run the Installer 
,program by double-clicking on its Icon. 

Once you are in the Installer, choose from the left hand side of the 
window the installation you wish to perform. There are versions for 
System Software 6.0, and 6.0.1 (each have slightly different device 
drivers which can't be mixed). Once you choose which System 
Software you are installing discQuest into, the right side of the 
window will allow you to choose a directory to place the actual 
disc Quest application program m. 

Clicking the "Install" button will begin the installation. The following 
files will be copied to your System folder: 

Fonts/CoPilot.8 a nice monospace font best suited for 
displaying text off of CD's 

FSTs/HS.FST a "File System Translator" which helps your 
IIOS read the ISO 9660 CD-ROM format 

IMP 0 R TAN T: the Installer does not copy the necessary devic 
drivers for your SCSI card onto your hard drive. If you have a 
RamFAST, no additional drivers are necessary. For an Apple SCSI 
card, you need to install the "SCSICD.Driver". Choose "Drive: CD­
ROM" in the SYstem Software Installer program. 

The application will be copied into the directory you specified. You 
should now reboot your computer to make sure the new System files 
are loaded and active. 

If you run into a problem installing the RamFAST card or CD-ROM 
drive, call Sequential Systems toll-free technical support and we'll be 
happy to help you. 
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Startup and Browsing 

When you run discQuest, it scans all available drives for a CD-ROM 
device. Then it checks to see if the CD-ROM contains a DiscPassage™ 
or other recognizable CD. When a usable CD has been found, 
discQuest opens up the "Browse" window. 

The Browse window lets you view the contents of the CD in "catalog" 
or "Table of Contents" format. Since CD-ROMs often contain hundreds 
of megabytes of data, the information is broken down into categories 
and sub-categories, much like subdirectories on a hard disk drive. In 
fact, discQuest represents subcategories with a folder icon just like 
that used by the Finder™. 

L::J 
L::J Educationa 1 Resources & Support Groups 
L::J Heal th Update Bookhts 
L::J Illustrations 
L::J The Consumer Guide (R) to PrescriPtion Drugs 
L::J Anatomy of the Human Body 
T Glossonl of Bod!! Ports 

Text documents are represented with a 'T' icon, pictures are 
represented with a 'P' icon, and audio samples are represented by a 
loudspeaker icon. (Audio playback is not universally supported in 
discQuest 1.0, see Appendix C for details). 

Double-clicking on an item, or selecting the 'Open' menu item will 
view or play the item. 

At the top of the Browse window are three buttons: Search, Back, and 
Top. If you've opened several categories and want to go back to the 
previous one, click the 'Back' button. If you want to go all the way 
back to the main table of contents, click the 'Top' button. 
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Clicking the 'Search' button will allow you to search one of up to four 
indexes, in the main category you have selected or opened. Each 
main category can (but isn't required to) have its own separate index 
files. For instance, if a CD had main categories of "Novels" and 
"Poems", selecting "Poems" and clicking "search" would only scan the 
indexes associated with the Poems, not those with Novels. This 
separation of indices usually occurs only at the' top level of a CD. 

The following keypresses can be used to navigate the Browse 
window: 
<Return> Open Item 
Apple-O Open Item 
<Arrows> Select Item 
ESC Go back one level (same as "Back" button) 
Apple-ESC Go back to top level (same as "Top" button) 

Search 

The Search window appears when you click the "Search" button in 
the Browse window. The Search windows contains the following 
elements: 

S h K 'L.:.::m=en=in=gi=ti=S====~ eorc eys ,- Jii=:===:=~ I'"":~:--"" 

Typing a word into one of the Search Key fields and pushing the 
"Search" button will search the relevant index for all files that 
contain that word. There are often several indices you can search, 
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selectable by the square "pop-up" menu (labelled "Words" in the 
window above): 

Words - searches all words in all documents in this index 
Subjects - searches only the subject summary keywords 
Titles - searches only document titles 
Authors - searches only "author" fields in the documents 

Note that not all CD's have all four of these indices. If you search on 
an index that a particular CD does not have, disc Quest will display an 
error message, cancel the search, and allow you to try a different 
index. 

You choose the index to search by selecting it from the pop-up menu 
to the right of the "Search" button. 

When the search is complete, the number of documents that are 
selected appears in the middle left of the Search window. If this 
number is less than twenty (20), the titles of the documents are 
automatically displayed in the list at the bottom of the Search 
window. If there are more than twenty, you must manually click the 
"Titles" button to get a list of matching titles. You may also enter 
another search word into the second "Search Keys" field to narrow 
the search. Only documents that contain bot h words will be 
selected. 

Once you have a list of matching titles, you may select a document to 
view by using the arrow keys or the mouse, and clicking the "Read" 
button (or pressing the <Return> key). 

Viewing Documents 

Much of the time, documents that are listed in the Browse and Search 
windows are "text files"; that is, they contain English text, tables, etc. 
These documents are displayed with the standard "TextEdit" tool. 

To facilitate using data from discQuest in your own work, you can use 
the items in the Edit menu to copy data from a document into the 
clipboard. Simply use the mouse to select the data you want to copy, 
and choose "Copy" in the Edit menu. You may also save the entire 
document to a text file on disk by using the "Save As ... " item in the 
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File menu. You'll be asked for a filename and to pick the disk and 
directory where to save the file with a regular Standard File dialog. 

Printing a document is as simple as choosing "Page Setup" from the 
File menu to make sure your printer settings are correct, then 
choosing "Print" from the File menu. (See Appendix A for information 
on printer drivers). 

When a text document is being viewed, one or both of the following 
new menus will appear: 

Find 
Related Items 

The Find menu allows you to search the current document for a word 
or words. For instance, say that you had searched a database for 
"agrarian" and you had found and opened a large document. To find 
the particular reference, simply choose "Find", enter the word 
"agrarian", and press <Return> (or click the "Find" button). The 
contents will jump to the word (if it is in the text) and highlight it. 

To search for further occurrences of the word, use "Find Again" (or 
Apple-G). Each reference that is found will be highlighted in red. 

The Related Items menu often contains pictures, sounds, and tables 
that relate in some way to the text. On the Audubon's Birds CD, for 
instance, for each document that contains Audubon's original notes 
on the bird, the Related Items menu contains the birdsong (CD audio) 
and a picture of the bird. Related items can be tables of information, 
can display a picture and play audio at the same time, and any other 
number of things. 
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Viewing Pictures 

Since the discQuest CD's were originally made for the Macintosh and 
IBM PC, the pictures on them are large and have many colors. 
discQuest supports two methods of viewing these pictures: 
"grayscale", which is the fastest and provides, best detail, and a color 
rendering which provides reasonable color representation on the 
IIGS monitor. discQuest also allows the user to scroll these large 
pictures with the mouse. When a picture is viewed, it takes over the 
entire screen, so scrolling is smooth and quick (especially with an 
accelerator). Clicking the mouse button once will stop viewing the 
picture and return to the document you were viewing (or to the 
Browse window if you selected a picture from there). 

Overview/Half Size 
You can get an "overview" look at the picture, if it is larger than one 
screen, by pressing the space bar. The picture will be displayed half­
size. Pressing the space bar again will restore the full-size display of 
the picture. Note that half-sizing a color image results in "color 
mashing"; i.e., the resultant half-size picture will not have the same 
colors, and may look odd. 

Color/Grayscale 
While displaying a picture, you can switch between the two different 
rendering methods (grayscale, or black and white) by pressing the 
following keys: 

'0' - switch to grayscale 
'C' - switch to color 

Color rendering results in a (obviously) colorful image, although some 
detail is lost. Grayscale rendering produces the most detailed images. 
Grayscale is automatically chosen whenever you wish to print an 
Image. 
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Playing Audio 

On many of the discQuest CD's, there are Browse directories which 
contain lists of audio samples. Since these samples are CD-quality 
audio, to hear them you must have speakers or headphones plugged 
into the CD-ROM drive itself. You cannot. listen to audio samples 
through the IIGS' built-in speaker. 

If you purchased the discQuest bundle, you have a set of external 
speakers. Unlike many audio speakers, these speakers' magnets are 
shielded, and are specifically for use on computer systems. 
(Unshielded magnets can cause permanent distortions on computer 
monitors and erase disks I). 

Almost all CD-ROM drives have 1/8" headphone jacks on the front of 
the case, where you can plug in headphones or amplified speakers 
such as those shipped with the discQuest bundle. Some CD-ROM 
drives also have "RCA" audio jacks on the back of the unit, to allow 
you to connect the CD-ROM to a home stereo amplifier. 

Some items will play audio automatically when you bring them up 
(some pictures). Some audio tracks are played by choosing "Hear 
XXX" from the Related Items menu or opening an audio item from 
the Browse window. 

On most CD-ROM drives, the audio track will be started and will play 
to completion unless interrupted. While the audio is playing, you can 
continue to read documents or look at the list of items in the Search 
or Browse windows. Generally, opening a new document or moving 
to a new directory in the Browse window will cancel audio playback. 
However, on some hardware configurations (Apple SCSI Card and 
Apple CD-150) audio playback is more restricted as far as 
"background playing" of the audio is concerned. 
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Preferences 

You can change certain default behaviors of disc Quest by editing the 
discQuest preferences. Choose "Preferences" under the "Edit" menu 
at any time, and the following window will appear. 

.. .. . 
Il\\U Preferences 

HIilIlBHmn ~.....,',::..,' -=' __ -. 
Rendering I Color ~ 

Size []ill] 
Il!iooJro ~nnHIOO)g 

I Window k 

( Done ] 

Rendering controls whether images are initially displayed in Color or 
Grayscale. You may still switch between modes with the keyboard 
commands discussed in "Viewing Pictures". The default is Grayscale. 

Size controls whether images initally are displayed half-size or full­
size. Again, you can change this with keyboard commands when 
viewing the picture. 

Finally, Image Scrolling allows you to choose the method by which 
mouse movements cause the picture on the screen to move. Window 
mode is the default, and moving the mouse up (forward) will move 
the display "window" towards the top of the picture. The other scroll 
mode is "page" mode; moving the mouse up (forward) causes the 
'page' the image is on to move up (resulting in the image moving 
down on the screen). 

Preferences are stored m the file "DQ.Prefs". 
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Troubleshooting 

When I'm in the Finder and I insert a CD-ROM into the 
drive, nothing appears. 

RamFAST: Run the RamFAST utility program (see the RamFAST 
manual) and choose "SCSI Utilities" from the menu. Make sure that 
the CD-ROM drive appears in the list of SCSI devices. If it does not: 

• Make sure the CD-ROM drive is powered on before you turn on 
your computer. 

• Make sure that the CD-ROM's SCSI ID does not conflict with the 
SCSI ID of another device on your SCSI chain 

If the CD-ROM drive does appear in the list of SCSI devices: 
• Make sure that your RamFAST has Version 3.01e of the 

RamFAST firmware (the first screen in the utility program will 
tell you this). If you need a ROM update, you can order one 
from Sequential Systems' toll-free sales line. 

Check Drivers and FSTs: 
• Make sure that you properly installed the High Sierra/ISO 

9660 FST (File System Translator) onto your hard drive. Look 
in the "System: FSTs" folder for "HS. FST". 

• If you have an Apple SCSI card, make sure the 
" S Y s t em: Dr i ve r s" folder on your hard disk contains 
" " d" ." SCSI.Manager an SCSICD.Drlver. 
If you have a RamFAST SCSI card, make sure the 
"System:Drivers" folder contains "RamFAST.Driver". 

You can install drivers either by using the discQuest "Hard Disk 
Installer" diskette, or by using the System Software installer to place 
the "Drive: CD-ROM" package on your hard drive. If you have an 
Apple SCSI card, you must use the System Software installer 
(discQuest does not come with the appropriate Apple SCSI drivers). 
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discQuest says "Unable to locate discPassage CD" on startup 

.. See "In Finder Nothing Appears" above. 

Make sure that the CD you are attempting to use is in fact a 
"discPassage" CD-ROM. These CD's almost always have the 
"discPassage" logo on them. discQuest is not needed for CDs 
that are IIGS-specific or have IIGS-specific files on them (such 
as the Apple Developer Group CD-ROMs). 

The only SCSI device on my SCSI card is the CD-ROM drive, 
and I have crashes or the CD-ROM is not recognized. 

.. RamFAST: if you boot straight into GS/OS (with a System 
Software boot disk other than that provided by Sequential) the 
RamFAST will crash about half-way through the boot. If you 
then "warm reboot" (press Control-OpenApple-Reset) the 
system will boot properly. The only workaround is to first boot 
directly into ProDOS 8 (which is exactly what our standalone 
boot disk does). 

.. Apple HS or Rev C SCSI: the Apple SCSI cards will normally 
only work with a CD-ROM drive if there is also a hard drive on 
the SCSI chain. The Apple SCSI card manual discusses a way to 
work around this by changing the card's SCSI ID. 
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Appendix A: Printer Drivers 

Compati bili ty 

discQuest has been tested with the following printers and drivers: 

ImageWriter (I & II) Apple Image Writer Driver 
Vitesse Perfect-Image 

HP DeskJet Series 
StyleWriter 
LaserWriter IIf 

Vitesse Harmonie, Seven Hills Independence 
Apple StyleWriter Driver 
Apple LaserWriter Driver 

Installing Drivers 

The floppy-based version of discQuest comes with the Apple 
ImageWriter driver pre-installed. If you wish to print to any other 
type of printer (or to a printer on a network) you will have to run 
the System Software "Install" disk or the "Install" disk of the third­
party drivers you use to copy the proper drivers onto the disc Quest 
disk. 

You should do this only to a backup of the discQuest diskette (see 
Introduction for instructions on how to make a backup disk). 

Many of the pictures on supported CD titles are complex images, and 
do not print well on an ImageWriter with Apple's standard driver. 
We recommend Vitesse's "Perfect Image" ImageWriter drivers, 
which allow the user to finely control many aspects of printing color 
images. Vitesse may be reached at: 

Vitesse, Inc. 
PO Box 929 
La Puente, CA 91747-0929 
(818) 813-1274 
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Appendix B: Supported Graphics Types 

discQuest has the capability to display several different types of 
graphics files that appear on the supported CD's. These are: 

Adobe TIFF 
Topix '.SCF' (formerly RIX-Works) 
Windows .BMP 

In all cases except .BMP files, the 640x480 pixel image is read into 
memory, the 256 entry color palette is converted to a 16-color (or 
16-level grayscale) palette, and each pixel in the file is remapped to 
that new palette. This process is written in assembly language and is 
very fast, even on an un-accelerated Apple IIGS . 

. BMP files are 16-color, and appear on the Family Doctor CD-ROM, but 
are not currently used by disc Quest. 

Note that discQuest itself can only display these types of picture files 
if they are on a discQuest CD-ROM. Sequential may produce a 
standalone graphics file viewer program in the future. 

Appendix C: Supported Hardware 

The following combination of SCSI interfaces and CD-ROM drives 
have been tested and are supported by disc Quest. 

SCSI Interface 
Apple Hi-Speed SCSI 

Sequential RamP ASTTM 

CD-ROM Drives 
Apple CD-150 & CD-SC+ 
Pioneer DRM-600 series 
Apple CD-300 (no audio) 
Apple CD-150 & CD-SC+ 
Pioneer DRM-600 Series 
Sequential discQuest CD-ROM Drive 
NEC (any model) 
Texel (any model) 
"SCSI-II Standard" (includes Sony, 
Toshiba, Phillips, NEC, Texel; Apple CD-
300 & PowerCD) 
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Glossary 

CD-ROM 

FST 

High Sierra 
ISO 9660 

MuI timedia 

SCSI 

"Compact Disc - Read Only Memory". CD-ROMs are 
based on Sony's compact disc technology and are 
also "read-only", meaning that one can retrieve data 
from CDs but cannot change or add information to 
them, like a floppy disk or hard disk. 
Short for "File System Translator". A GS/OS FST 
allows GS/OS to access new types of "File Systems". 
For example, the ProDOS FST allows GS/OS to access 
Apple II ProDOS disks, and the HFS FST allows 
GS/OS to access Macintosh disks. See "ISO 9660". 
See "ISO 9660" 
ISO 9660 (also known as High Sierra) is the 
industry-standard file system used on CD-ROMs. 
While CD-ROMs can be made with any file system 
(such as ProDOS or Macintosh HFS), most CD-ROMs 
are ISO format. You must have "HS.FST" installed m 
your System Software to use these CD-ROMs. 
Meaning "many types media". Generally refers to 
software that mixes audio, still pictures and text, 
and movies or other animation. Many CD-ROMs are 
"Multimedia" . 
(pronounced 'scuzzy') "Small Computer System 
Interface"- an industry standard way of connecting 
fast peripherals to a computer. SCSI adapters or 
interface boards (like the RamFAST or Apple High 
Speed SCSI card) are required for an Apple II to 
use SCSI devices. 
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